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FOREWORD

The IAEA initiated in 1990 a programme to assist the countries of
eastern Europe and the former Soviet Union in evaluating the safety of
their first generation WWER-440/230 nuclear power plants. The main
objectives of the Programme were: to identify major design and
operational safety issues; to establish international consensus on priorities
for safety improvements; and to provide assistance in the review of the
completeness and adequacy of safety improvement programmes.

The scope of the Programme was extended in 1992 to include
RBMK, WWER-440/213 and WWER-1000 plants in operation and under
construction. The Programme is complemented by national and regional
technical co-operation projects.

The Programme is pursued by means of plant specific safety
review missions to assess the adequacy of design and operational
practices; Assessment of Safety Significant Events Team (ASSET)
reviews of operational performance; reviews of plant design, including
seismic safety studies; and topical meetings on generic safety issues.
Other components are: follow-up safety missions to nuclear plants to
check the status of implementation of IAEA recommendations;
assessments of safety improvements implemented or proposed; peer
reviews of safety studies; and training workshops. The IAEA is also
maintaining a database on the technical safety issues identified for each
plant and the status of implementation of safety improvements. An
additional important element is the provision of assistance by the IAEA
to strengthen regulatory authorities.

The Programme is extrabudgetary and depends on voluntary
contributions from IAEA Member States. Steering Committees provide
co-ordination and guidance to the IAEA on technical matters and serve as
forums for exchange of information with the European Commission and
with other national, international and financial organizations. The general
scope and results of the Programme are reviewed at Advisory Group
meetings.



The Programme, which takes into account the results of other
relevant national, bilateral and multilateral activities, provides a forum
to establish international consensus on the technical basis for upgrading
the safety of WWER and RBMK nuclear power plants.

The IAEA further provides technical advice in the co-ordination
structure established by the Group of 24 OECD countries through the
European Commission to provide technical assistance on nuclear safety
matters to the countries of eastern Europe and the former Soviet Union.

Results, recommendations and conclusions resulting from the
IAEA Programme are intended only to assist national decision makers
who have the sole responsibilities for the regulation and safe operation
of their nuclear power plants. Moreover, they do not replace a
comprehensive safety assessment which needs to be performed in the
frame of the national licensing process.

EDITORIAL NOTE

In preparing this publication for press, staff of the IAEA have made
up the pages from the original manuscript (s). The views expressed do
not necessarily reflect those of the governments of the nominating
Member States or of the nominating organizations.

Throughout the text names of Member States are retained as they
were when the text was compiled.

The use of particular designations of countries or territories does not
imply any judgement by the publisher, the IAEA, as to the legal status
of such countries or territories, of their authorities and institutions or
of the delimitation of their boundaries.

The mention of names of specific companies or products (whether or
not indicated as registered) does not imply any intention to infringe
proprietary rights, nor should it be construed as an endorsement or
recommendation on the part of the IAEA.proprietary rights, nor should
it be construed as an endorsement or recommendation on the part of the
IAEA.
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SUMMARY

At the beginning of the IAEA Extrabudgetary Programme on the
safety of WWER reactors a great number of findings and
recommendations (safety items) were collected as a result of design
review and safety review missions of the WWER-440/230 type reactors.
On the basis of these findings a technical database containing more than
1300 records was established to support the consolidation of the
information obtained and to help in identification of safety issues. After
the scope of the WWER extrabudgetary programme was extended similar
data sets were prepared for the WWER-440/213, WWER-1000 and
RBMK nuclear power plants.

This publication describes the structure of the databases on safety
issues of WWER and RBMK NPPs, the information sources used in the
databases and interrogation capabilities for users to obtain the necessary
information.

The IAEA has also assisted the G-24 Nuclear Safety Assistance
Co-ordination (NUSAC) Secretariat to establish a database on nuclear
safety assistance to countries of eastern Europe and of the former Soviet
Union. This database serves as a management tool for coordination of the
assistance projects. An important result of this cooperation is the
harmonization of the structure and the software of the G-24 Project Data
Bank and the technical databases maintained at the IAEA. Such a link
between different databases facilitates the analysis of gaps and overlaps in
the assistance programmes.



1. GENERAL DESCRIPTION OF DATABASES

At the beginning of the IAEA Extrabudgetary Programme on the
Safety of WWER Reactors a great number of findings and
recommendations (safety items) were collected as a result of design
review and safety review missions of the WWER-440/230 type reactors.
On the basis of these findings a technical database containing more than
1300 records was established to support the consolidation of the obtained
information and to help in the identification of safety issues. As a further
step, the WWER-440/230 safety issues and their priorities have been
published as an IAEA Technical Document [l].This publication has been
a basic reference for the follow-up safety review missions and for the
planning and implementation of the WWER-440/230 extrabudgetary
programme activities.

When the scope of the programme was extended to include the
WWER-440/213, WWER-1000 and RBMK NPPs a similar approach was
used for these reactor types. Information on reviews of safety
improvements, results of topical meetings, technical committee meetings,
ASSET and OS ART missions were consolidated in safety issues. In this
work the results of other programmes (e.g. Consortium for RBMK
reactors, Risk Audit studies) were also taken into account.

The safety issues for the WWER and RBMK NPPs are all included
in the relevant IAEA databases. The databases also contain the safety
items used for the consolidation of safety issues. An overview on the
databases including their current size and the number of records in the
primary tables is given in Table I.

All forms, queries and report formats which were used for the data
input have been removed from the databases and only database objects
necessary for the interrogation and output have been kept. This has
reduced the size of the files.

The structure of the databases allows for the input of specific
actions which are taken by individual plants in order to address safety
issues. The status of implementation of safety modifications varies from
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plant to plant. Therefore, periodic technical visits to the plants are
conducted by the IAEA to update the inputs on the implementation of
safety upgrading programmes. This information is then included in the
database.

The IAEA has also assisted the G-24 Nuclear Safety Assistance
Coordination (NUSAC) Secretariat to establish a database on nuclear

TABLE I. OVERVIEW OF THE DATABASES

Database

WWER-440/230

WWER-440/213

WWER-1000

RBMK

Total:

Size Mbyte

2.26

1.08

0.85

1.15

5.34

Number of records

1419

1244

1037

2413

5077

safety assistance to countries of eastern Europe and of the former Soviet
Union. This database serves as a management tool for coordination of
the assistance projects. An important result of this cooperation is the
harmonization of the structure and the software of the G-24 Project Data
Bank and the technical databases maintained at the IAEA. Such a link
between different databases facilitates the analysis of gaps and overlaps
in the assistance programmes and gives an opportunity to perform
simultaneous analyses of these databases.

In order to ensure the high reliability of information in the
databases all inputs have been reviewed by international experts. All
information compiled is free for distribution to the IAEA Member
States, since the databases contain only information from IAEA
publications and other reports which were made available to the IAEA.



In the beginning, the databases were built up using dBase IV as the
database management software. This solution had two major limitations.
Firstly, the primary information source is mostly text oriented (findings
and recommendations of reports and missions), and secondly, the
analytical approach of analysis used at the IAEA required a wide range
of combinations of different textual information. Therefore, it was
decided to transfer all the data into Microsoft ACCESS running in the
Windows environment.

The data are organized in series of so-called "primary tables".
Each primary table contains either recommendations or plant status for
safety issues identified for the four reactor types. The list of primary
tables and their sizes are described in the following sections.

In order to facilitate data retrieval a dialog screen was developed
which offers an easy way to display and print the necessary information.
The layout and usage of a dialog screen for each reactor type are
described below.

The databases are available in run-time format on four diskettes.
They can be installed on an IBM compatible personal computer with a
386 processor or higher. To run the databases the computer should meet
the following requirements: hard disk with 8 megabyte free space,
Microsoft Mouse or compatible pointing device, VGA or compatible
display, four megabyte of random access memory and Microsoft
Windows® version 3.1 or later.

The databases can be obtained upon written request from the
IAEA's Division of Nuclear Installation Safety. The IAEA staff
members responsible for this work were Mr. Laszlo Czibolya and Ms.
Marja Zrunek of the Safety Assessment Section of the Division of
Nuclear Installation Safety.

To set up the databases insert disk 1 in drive A. In Windows
Program Manager choose Run from the File menu. Windows displays
the Run dialog box. Type "a:setup" in the Command Line box and
choose OK button. Follow the setup instructions on the screen.
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2. WWER-440/230 DATABASE

2.1. STRUCTURE AND FEATURES

In 1992 the IAEA issued a technical document [1] containing inter
alia the results of the design concept review and the safety review
missions to all WWER-440/230 plants.

The information included in [1] was taken as a basis to establish
the database on findings and recommendations for the WWER-440/230
reactors.

The size of the database on findings and recommendations for
WWER-440/V-230 reactors is 2 Mbytes. The primary tables with the
number of records in each of them are listed in Table II. The database
includes three more tables which are not listed because they are used
exclusively as a part of the software to handle the main screen form of
data display.

The structure of the database is shown on Fig. 1. The central
table, named TECDOC-640, contains the following fields:

PRISSCD Issue number as defined in [1].

ITITLE Title of the issue.

IC AT Category of the issue (I—IV).

RECOMMENDATION Conceptual recommendation of the
IAEA for the issue.

IAEALINKCODE Issue code ensuring the link
between the WWER-440/230
database and the G-24 Project Data
Bank.

All other tables are connected to the central table. The left side of
Fig. 1 shows the tables with various sets of recommendations which
have been elaborated in response to the international concerns to address
the WWER-440/230 safety issues. Four sets of these recommendations
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are included in the database. These are the regulatory requirements for
the Bohunice NPP (so-called 81 + 14 measures), Consortium
recommendations for the Kozloduy NPP, additional recommendations of
the IAEA for Novovoronezh as a result of the safety review follow-up

TABLE II. PRIMARY TABLES IN THE WWER-440/230
DATABASE

Primary table name

TECDOC-640

81 + 14 measures

81 + 14 measures - issue

Additional recommendations for
Novovoronezh (1993, design)

Bohunice

Consortium

Consortium - issue

IAEA comments

KOLA

NOVOVORONEZH

KOZLODUY

Safety area types

Safety areas

Total:

Number of
records

99

92

96

34

97

212

233

53

95

97

99

94

118

1419
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Consortium
ID
Recommendation
Measure

Consortium-issue
ID
IAEALINKCODE

Bohunice
PRISSCD
Plant action
Data updated
Status
Status number

81+14 Measures
ID
Recommendation
Measure

81 +14 Measures-issue
ID
IAEALINKCODE

TECDOC-640
PRISSCD
ITITLE
ICAT
RECOMMENDATION

Additional
recommendations
for Novovoronezh
PRISSCD
RECOMMENDATION

IAEA comments
PRISSCD
ITEM
IAEA comment

Safety areas
IAEALINKCODE
saidtcd
pacovpc
pacomtx

Kozloduy
PRISSCD
Plant action
Data updated
Status
Status number

Kola
PRISSCD
Plant action
Data updated
Status
Status number

Novovoronezh
PRISSCD
Plant action
Data updated
Status
Status number

FIG. 1. Structure of the WWER-440/230 database.
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mission in 1993, and IAEA comments describing the remaining safety
concerns after the plant actions were reviewed in 1994 [2].

A "one-to-many" relationship is implemented between the tables
of recommendations and the central table, because usually several
recommendations address the same issue. This type of relationship can
be built using the so-called "relation table".

A meeting of international consultants convened by the IAEA in
September 1994 concluded that significant progress had been made in
addressing the safety problems of the ten operating WWER-440/230
units, but that several major safety concerns still remain. Progress on the
implementation of safety solutions varies from plant to plant and
depends on national resources and international assistance. A report [2]
on the plant specific status of safety improvements has been prepared
and information on plant actions gained during the preparation of the
report has been input into the database.

The right side of Fig. 1 shows the relevant tables containing the
description of the plant action, the date when the information was
obtained and the status of the issue at the plant. For the description of
the status a simple scale was used with the following codes:

for the design issues:

1 - No action
2 - Action under way

3 - Partly resolved

4 - Fully resolved

for operational issues:

1 - No action

2 - Little progress

3 - Satisfactory progress

4 - Complete

14



Edit File View

Select the issue by its code or title !
• - • —Mil iia*~™jj~""™~

DURESA NTFNANrF H?
Select the type of irforrration

forthis window!
Select the type of irforrration

forthis window!

Select the type of irforrration
for this window!

Select the type of irforrration
for this window!

FIG. 2. Main dialog screen of the WWER-440/213 database



The report was complemented with a print-out from the database
in a separate volume on plant actions for each issue.

2.2. USER INTERFACE

For convenient use of the database a specific user interface screen
was developed. This screen offers several options for the selection of
various sets of data for display. The contents of four tables can be
displayed simultaneously from the eight primary tables. In addition, the
related recommendations [1] can be selected from the menu. A powerful
text search option has also been implemented. Figure 2 shows the user
interface screen designed to display the status of a particular safety issue
at chosen NPPs and/or recommendations concerning that safety issue.

Start

To open the IAEA WWER-440/230 database double-click the
V-230 icon created by the setup programme. Click on the Start button
to display the main dialog screen (Fig. 2) which offers a flexible way to
select information from the database.

Selecting the data to be displayed

An issue may be selected either by its code or by its title in the
upper part of the screen. A new issue may be selected either from the
issue code or the issue title pop-up lists. (It is sufficient to select either
a new issue code or a new issue title The other fields change
automatically after a selection is made.)

A group of issues may be selected in two ways:

(a) To obtain a subset of issues and recommendations related to a
particular word in the database, type the word in the Find field (at the
top right of the screen) and press enter. The pop-up lists of issue codes
and issue titles will include the results of the search. The lists contain the
issues with the word in any of the text fields.

16



For example, type ECCS, press enter and the system will display
the selected issues and recommendations with the word ECCS in the
text.

(b) To select and display the full set of issues and
recommendations in the database type an asterisk, (*), in the Find field
and press enter. Accident analysis 1 will be the first issue displayed.

Issue category

Once the issue code or issue title is selected, the system will
display the category pertaining to the selected issue in the upper part of
the screen.

Selecting recommendations and plant status

In the four "sub-windows" of the screen either recommendations
or plant specific status can be displayed according the selection made by
clicking on the "Recommendation" or "Plant status" button. Open a
pop-up list and the particular set of recommendations or plant name will
be selected. After selecting the plants/recommendations the issue can
also be reselected.

To view the data, select the Display option from View menu bar
at the top of the screen.

New selection

The top line of each of the four sub-windows indicates which data
is being displayed (plant name or the name of the set of
recommendations). The data changes automatically after a new safety
issue is selected. However, in order to see data on other plants or other
sets of recommendations press the "New selection" command button in
the upper part of the screen.

17



IAEA recommendations for the issue (TECDOC-640)

To see the corresponding recommendation from [1], select
"TECDOC 640" menu option from the View menu bar. Click on OK to
close the window and continue.

Link with the G-24 Project Data Bank*

Under the Link menu from the customized menu bar two menu
items are available.

Show the link to G-24 Data Bank

Select this item to display the diagram showing the link between
the G-24 Project Data Bank and the IAEA databases. Click on OK to
close.

Export link table

If the G-24 Project Data Bank is installed on your computer you
can create a table which provides a link between the IAEA technical
databases and the G-24 Project Data Bank. Click on Export link table
to display the Generate table linking to G-24 Project Data Bank
dialogue box. The Generate button creates a link table for the selected
issues or the currently displayed issue. After generation, the Export
button is activated in bold face letters. Type in the correct path to the
G-24 data bank on your PC, then click on Export. An error message
will be displayed if the indicated path is incorrect. Click on OK and
make the necessary change to the path, then click on Export again. The
table will be exported to your G-24 data bank file which can then be
used for further analysis.

Note, if the export operation is cancelled after generation of the
table, generation must be made again before the export function can be
performed.

* For the G-24 Project Data Bank contact the G-24 NUSAC Secretariat in Brussels.
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3. RBMK DATABASE

3.1. STRUCTURE AND FEATURES

In the frame of the Extrabudgetary Programme on RBMK type
reactors the IAEA has also prepared a list of design and operational
safety issues for this reactor type [3]. During the preparation of this
document the database on findings and recommendations for RBMK
reactors was extensively used. From the working materials of previous
meetings, the safety review mission reports to Smolensk and Ignalina,
the ASSET reports and recommendations of the International
Consortium sponsored by the European Commission, more than 1000
safety items were collected in the initial version of the database. The
safety items were grouped by topical areas which gave a powerful tool

TABLE III. PRIMARY TABLES IN THE RBMK DATABASE

Primary table name

RBMK Issues

IAEA recommendations

RBMKIS2 (safety items)

Plant status (RDIPE)

RDIPE date on plant actions (reltab)

Issue RDIPE relation table

•
Issue 95-measure relation table
Safety area types

Safety areas

Total:

Number of
records

58

153

1016

79

85

81

772

94

75

2413
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to consolidate the available information into 60 safety issues. In
addition, recommendations of the topical reports on multiple tube
rupture and on the shutdown system of RBMK reactors have been added
into the database.

The primary tables and the number of records in each table are
listed in Table III. Three tables are used only for displaying the data on
the main screen and therefore they are not listed here.

The basic central table of the RBMK database is the table "RBMK
issues" which contains the following fields:

ID Identification number (index
field).

Issue number Code number of the issue with the

reference to the topical area.

Issue title Title of the issue.

Clarification Description of the safety concern.
Category Category identified on the basis of

degradation of defence in depth
(high, medium and low).

Justification Justification of the category.

Applicability Applicability of the issue to the
various generations of the RBMK
reactors.

Issue code Code used internally in the
software.

The IAEA recommendations for the issues are included in a
separate table which is linked to the issues through the issue number.

The main design institute (RDIPE, Moscow) of the RBMK
reactors made available to the IAEA data on the safety upgrading

20



Issue95-measure relation
table

ID
Issue code

IAEA recommendations
ID
IAEA recommendations
Issue code

RBMK IS2
ID
Description
Source
Topic
Status
Reference
(Consortium)
(Smolensk mission)
(Ignalina mission)
(ASSET missions)
(TECDOC-694)
(TCM-92)

RBMK Issues
ID
Issue number
Issue title
Clarification
Category
Justification
Applicability
Issue code

Issue-RDIPE relation table
ID
Issue number

Plant status (RDIPE)
ID
Plant action

RDIPE data on plant actions (rel tab)
MID
Name
Unit
Status
ID

v J

Safety areas
IAEALINKCODE
saidtcd
pacovpc
pacomtx

Safety area types
saidtcd

G-24 data bank

FIG. 3. Structure of the RBMK database.
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programmes of individual plants addressing the safety issues. This
plant specific information is also part of the database.

The database includes references to the original publications
where the data were obtained. An interface table with the G-24 Project
Data Bank can be prepared which makes the joint analysis of
information from both databases easier.

The structure of the RBMK database is given in Fig. 3. This
structure allows extension of the database with the plant specific data
as the Extrabudgetary Programme of the IAEA progresses and the
information becomes available. The attempt to include in the database
the insights of the topical reports proved to be useful. The inclusion of
the full text of reports is being considered as a possible future
development.

3.2. USER INTERFACE

In order to facilitate the interrogation of the database a dialog
screen format was developed (Fig. 4). On this screen the user can
select a particular safety issue to display the information contained in
the issue sheets of [3].

Start

To open the IAEA RBMK database double-click the RBMK
icon created by the setup programme. Click on the Start button to
display the main dialog screen (Fig. 4) which offers a flexible way to
select information from the database.

Select the issue

An issue may be selected either by its code or by its title in the
upper part of the screen. A new issue may be selected either from the
new issue code or the issue title pop-up lists. (It is sufficient to select
either a new issue code or a new issue title, the other fields change
automatically after a selection is made.)
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A group of issues may be selected in two ways:

(a) To obtain a subset of issues and recommendations related to
a particular word in the database, type the word in the Find field (at the
top right of the screen) and press enter. The pop-up lists of issue codes
and issue titles will include the results of the search. The lists contain
the issues with the word in any of the text fields.

For example, type ECCS, press enter and the system will display
the selected issues and recommendations with the word ECCS in the
text.

(b) To select and display the full set of issues and
recommendations in the database type an asterisk, (*), in the Find field
and press enter. Accident analysis 1 will be the first issue displayed.

Issue category, clarification, justification and recommendations

Once the issue code or issue title is selected, the system will
display the category and issue clarification pertaining to the selected
issue in the upper part of the screen.

Click on the Justification button to display the justification of the
category.

Recommendations for the issue and related safety items were
taken from various information sources and are identified on the left
side of the bottom half of the screen. The recommendations listed under
IAEA are from Ref. [3]. Those listed under Consortium are the
recommendations of the International RBMK Safety Project sponsored
by the European Commission. Smolensk and Ignalina
recommendations are the results of IAEA safety review missions to
those two plants [4], [5]. RDIPE items include data provided by the
RDIPE to the IAEA on plant status. ASSET recommendations are
those which were developed during Assessment of Safety Significant
Events Teams (ASSET) missions [6]. Other items displays items
which were derived from earlier IAEA documents [7], [8].
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The references which contain information related to the displayed
issue are enabled in boldface letters and may be selected. No information
is available from those references which are shadowed in grey letters,
are disabled and are unaccessable.

To display the recommendations contained in Ref. [3], click on
the IAEA button which is located at the bottom left of the screen. The
system will display the number of recommendations which the IAEA
made for the selected issue and these can be read in turn when the Next
button is used (at the bottom right of the screen). This button also scrolls
forward through the entire list of selected issue recommendations. To
scroll backwards click on the Previous button.

The RDIPE subset may also have plant information on actions
relating to the selected issue. In this case, the Plant actions button (at
the bottom left of the screen) is enabled in boldface letters. Click on this
button to open the window with the different plant names at the bottom.
Plant names are enabled in bold face letters when information is
available on their actions relating to the selected issue. Select a plant
name and the system will display the unit(s) for which such plant actions
are applicable. Close the window to continue.

Topical reports

In the framework of the IAEA Extrabudgetary Programme on
safety of RBMK NPPs topical meetings are organized to review some of
the most important safety issues. Recommendations of two topical
meetings [9], [10] are included in the database under Topical reports.

The topical reports icon, an open book, is displayed when
recommendations from these reports relating to the selected issue are
available. Click on the Open book button to display these
recommendations. The number of recommendations is displayed as well
as the reference identification number of the particular topical report. To
scroll forward through the list of recommendations, click on the Next
button, to scroll backwards, click on the Previous button. Click on OK
to close the window and continue.
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Menu bar

The database has a customized menu bar with file, references,
print and link menu names. The commands under the menu names are
executed in the following way.

File menu on the menu bar

Copy

To copy text from the clarification, justification, or
recommendation areas, block, and select the text then click on File in
the menu bar and select Copy, (for the Topical reports press Ctrl+C
to copy). The selected text can be pasted into word processing, spread
sheet or other applications.

Exit

To exit the database, click on Exit in the File menu. All the
Microsoft ACCESS files will be closed and the system will exit the
application.

References menu on the menu bar

Info sources

Select the Info sources menu item from the References menu to
display a list of publications used as information sources in the database.
Close the window to continue.

Topical reports

Topical reports menu item displays a list of IAEA topical reports
quoted in the recommendations in the Topical reports area of the
database. Close the window to continue.
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About...

About... displays the names and addresses of the contact persons,
relating to the IAEA Extrabudgetary Programme and the developer of
the database. Click on OK to close the window.

Print menu on the menu bar

Print

To print a selected group of issues (for example, from the Find
operation previously performed), or the issue currently displayed on the
screen, click on the Print menu and choose Print.... The Report
printing window will be displayed. Choose Selected items or Current
issue, then select specific related items from the references which are
enabled on the particular issue(s) or All items (to print all items related
to the issue(s) selected). Click on Print and the Print dialogue box will
be displayed indicating the default printer name and the requested print
range To display a preview, before printing, click on the Print preview
button. Click on OK to start printing.

Print setup

The usual Windows Print Setup dialogue box will be displayed.
Choose the printer, orientation, paper size, etc., which are appropriate
for the available hardware. Click on OK to close.

Link with the G-24 Project Data Bank*

Under the Link menu from the customized menu bar two menu
items are available.

Show the link to G-24 Data Bank

Select this item to display the diagram showing the link between

* For the G-24 Project Data Bank contact the G-24 NUSAC Secretariat in Brussels.
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the G-24 Project Data Bank and the IAEA databases. Click on OK to
close.

Export link table

If the G-24 Project Data Bank is installed on your computer you
can create a table which provides a link between the IAEA technical
databases and the G-24 Project Data Bank. Click on Export link table
to display the Generate table linking to G-24 Project Data Bank
dialogue box. The Generate button creates a link table for the selected
issues or the currently displayed issue. After generation, the Export
button is activated in bold face letters. Type in the correct path to the
G-24 data bank on your PC, then click on Export. An error message
will be displayed if the indicated path is incorrect. Click on OK and
make the necessary change to the path, then click on Export again. The
table will be exported to your G-24 data bank file which can then be
used for further analysis.

Note, if the export operation is cancelled after generation of the
table, generation must be made again before the export function can be
performed.

4. WWER-440/213 DATABASE

4.1. STRUCTURE AND FEATURES

In 1993 the IAEA Extrabudgetary Programme on the Safety of
WWER Nuclear Power Plants initiated the systematic work on
compiling and ranking of safety issues for WWER 440/213 reactors. A
report listing safety issues identified by the WWER 440/213 owners was
completed under an IAEA contract in the middle of 1993 and after a
review by WANO was presented at a WANO conference in Moscow in
March 1994.

The problems connected with bubbler condenser containment
were studied under an IAEA/TC RER/9/004 project and discussed at an
IAEA Consultants' Meeting organized within the framework of the
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IAEA Extrabudgetary Programme in Vienna in November 1993. At the
same time, the major findings of the RER/9/004 project concerning the
design and design basis of WWER 440/213 reactors were summarized
in Ref. [11] and served as an important input to further work on issue
ranking.

In April 1994, an IAEA Consultants meeting on WWER 440/213
"Backfittings and Safety Issues" was organized within the framework of
the IAEA Extrabudgetary Programme. It was further reviewed and
completed by the IAEA Secretariat, taking into account the comments
from the Steering Committee. The papers presented by all NPPs and
several organizations concerned with WWER 440/213 safety studies
helped to establish a draft list of safety issues and their ranking.

A final Consultants meeting was convened by the IAEA from 27
February to 3 March 1995 to harmonize the safety issues and ranking of
both reactor types, WWER-440/213 and WWER-1000/320.

This finalized list of safety issues is included in a publication of
the Extrabudgetary Programme [12].

The list of the safety issues was taken as a basis for creating a
database on WWER-440/213 reactors. The basic primary table, named
"WWER-213 Issues", contains the following fields:

ID

Issue number

Issue title

Clarification

Ranking

Justification

Identification number (mdex field).

Code number of the issue with the
reference to the topical area.

Title of the issue.

Description of the safety concern.

Category identified on the basis of
degradation of defence in depth
(I-IV).

Justification of the category.
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The primary tables and the number of records in each table are
included in Table IV. Three tables are used only for displaying the data
on the main screen and therefore they are not listed here.

TABLE IV. PRIMARY TABLES IN THE WWER-440/213

Primary table name

WWER-440/213 Issues

IAEA recommendations

Measures proposed by Member States

Status

Safety area types

Safety areas relation table

Total:

Number of
records

87

232

186

521

94

124

1244

The database includes references to the original publications
where the data were obtained. An interface table with the G-24 Project
Data Bank can be prepared which makes a joint analysis of information
from both databases easier.

To a large extent, the identified safety issues are being addressed
by the Member States concerned within national safety improvement
programmes for WWER 440/213 NPPs. The most relevant safety
upgrading measures were compiled by the "Users Group for Soviet
Designed Reactors - WWER 440/213" based mainly on the proposals
made by user organizations. The structure of the database (Fig. 5)
reflects both the proposals of national and international programmes,
and plant specific status of issues.

30



Measures proposed by
Member States

ID
Issue code
Measure

IAEA recommendations
ID
IAEA recommendations
Issue code

V-213- Issues
ID
Issue number
Issue title
Clarification
Ranking
Justification

Safety areas
IAEALINKCODE
saidtcd
pacovpc
pacomtx

Status
Issue code
Plant specific status
Plant

Safety area types
saidtcd
sadestx

G-24 data bank

FIG. 5. Structure of the WWER-440/213 database.
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These corrective measures for each issue have been reviewed and
consolidated in the table "Measures proposed by Member States". The
corrective measures are generic as the issues themselves, i.e. in general
they are applicable to the units of the WWER 440/213.

The design weaknesses typical for the original WWER 440/213
plant described in safety issue clarification do not necessarily concern
all presently operating or planned units with this type of reactor. In
some reactors, e.g. in Loviisa NPP, far reaching changes were
introduced already during plant construction and an intensive safety
improvement programme has been implemented over several years.
Other units realized some improvements in the early years of operation
and have recently made major efforts for safety enhancement, or plan
to introduce significant changes in the near future. Thus some safety
concerns do not apply to several of the WWER 440/213 units.

The table "Status" includes the actual country /plant specific
status determined partly by the IAEA staff upon the basis of available
literature or the IAEA's own mission reports but mostly as the result of
communications directly with the plants. In several cases, the plant
status has been repeatedly verified and supplemented with actual data
by the plant or by a joint action of specialists both from the plant and
the regulatory authority. However, this is not the case for all plants, so
that the level of detail in the plant status description varies in each case.

The data directly verified by the IAEA are only those taken from
the IAEA mission reports. So far, the missions for the safety
improvements review have been organized to three WWER 440/213
plants, namely Bohunice, Dukovany and Mochovce. The mission to
Paks is planned for the autumn of 1996. Further missions to the
remaining WWER 440/213 units are proposed. The results of these
missions will be reflected in the plant specific status description
supplementing and improving the data available at present. The
information has also been introduced into the IAEA database and will
be constantly updated as new sources of information become available.
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4.2. USER INTERFACE

A dialog screen for easy retrieval of information was developed
for the WWER-440/213 database on which all information from the
issue list can be displayed including the plant specific information (Fig.
6). On this screen the user can select a particular safety issue and
display the information contained in [12].

Start

To open the IAEA WWER-440/213 database double-click the
V-213 icon created by the setup programme. Click on the Start button
to display the main dialog screen (Fig. 6) which offers a flexible way
to select information from the database.

Select the issue

An issue may be selected either by its code or by its title in the
upper part of the screen. A new issue may be selected either from the
new issue code or the issue title pop-up lists. (It is sufficient to select
either a new issue code or a new issue title, the other fields change
automatically after a selection is made.)

A group of issues may be selected in two ways:

(a) To obtain a subset of issues and recommendations related to
a particular word in the database, type the word in the Find field (at the
top right of the screen) and press enter. The pop-up lists of issue codes
and issue tides will include the results of the search. The lists contain
the issues with the word in any of the text fields.

For example, type ECCS, press enter and the system will display
the selected issues and recommendations with the word ECCS in the
text.

(b) To select and display the full set of issues and
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recommendations in the database type an asterisk, (*), in the Find field
and press enter. Accident analysis 1 will be the first issue displayed.

Issue category, clarification, justification and recommendations

Once the issue code or issue title is selected, the system will
display the category and issue clarification pertaining to the selected
issue in the upper part of the screen.

Click on the Justification button to display the justification of the
category.

Recommendations of the IAEA, measures proposed by the
Member States for the issue, and status of the plants were taken from
[12].

The IAEA recommendations from Ref. [12] are displayed when
the IAEA button at the bottom left of the screen is selected. The system
displays the number of recommendations which the IAEA made for the
selected issue which can be read in turn when the Next button is selected
(at the bottom right of the screen). This button also scrolls forward
through the entire list of selected issue recommendations. To scroll
backwards click on the Previous button.

Information on the number of measures proposed by Member
States for the current issue are displayed when the Measures button is
selected.

Plant names are enabled in boldface letters, bottom left of the
screen, when information is available on the status of items relating to
the displayed issue or recommendation. Click on a particular plant name
button and the number of items for the issue are displayed which can be
read in turn when the Next button is used (at the bottom right of the
screen). This button also scrolls forward through the entire list of
selected issue recommendations. To scroll backwards click on the
Previous button.
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Menu bar

The database has a customized menu bar with file, references,
print and link menu names. The commands under the menu names are
executed in the following way.

File menu on the menu bar

Copy

To copy text from the clarification, justification, or
recommendation areas, block and select the text then click on File in the
menu bar and select Copy. The selected text can be pasted into a word
processing, spread sheet or other application.

Exit

To exit the database, click on Exit in the File menu. All the
Microsoft ACCESS files will be closed and the system will exit the
application.

References menu on the menu bar

Info sources

Click on Info sources from the References menu bar to display
a list of publications used as information sources in the database. Close
the window to exit.

About...

About... displays the names and addresses of the contact
persons, relating to the IAEA Extrabudgetary Programme and the
developer of the database. Click on OK to close the window.
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Print menu on the menu bar

Print

To print a selected group of issues (for example, from the Find
operation previously performed), or the issue currently displayed on the
screen, click on the Print menu and choose Print.... The Report
printing dialogue box will be displayed. Choose Selected items or
Current issue, then select specific related items from the references
which are enabled on the particular issue(s), or All items (to print all
items related to the issue(s) selected). Click on Print and the Print
dialogue box will be displayed indicating the default printer name and
the requested print range. To display a preview, before printing, click
on the Print preview button. Click OK to start printing.

Print setup

The usual Windows Print Setup dialogue box will be displayed.
Choose the printer, orientation, paper size, etc., which are appropriate
for the available hardware. Click on OK to close.

Link with the G-24 Project Data Bank*

Under the Link menu from the customized menu bar two menu
items are available.

Show the link to G-24 Data Bank

Select this item to display the diagram showing the link between
the G-24 Project Data Bank and the IAEA databases. Click on OK to
close.

For the G-24 Project Data Bank contact the G-24 NUSAC Secretariat in Brussels.
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Export link table

If the G-24 Project Data Bank is installed on your computer you
can create a table which provides a link between the IAEA technical
databases and the G-24 Project Data Bank. Click on Export link table
to display the Generate table linking to G-24 Project Data Bank
dialogue box. The Generate button creates a link table for the selected
issues or the currently displayed issue. After generation, the Export
button is activated in bold face letters. Type in the correct path to the
G-24 data bank on your PC, then click on Export. An error message
will be displayed if the indicated path is incorrect. Click on OK and
make the necessary change to the path, then click on Export again. The
table will be exported to your G-24 data bank file which can then be
used for further analysis.

Note, if the export operation is cancelled after generation of the
table, generation must be made again before the export function can be
performed.

5. WWER-1000 DATABASE

5.1. STRUCTURE AND FEATURES

The WWER-1000 nuclear power plants are more similar than
other reactors of Soviet design to PWRs of western design when
considering design philosophy, design features and construction. The
design of the model 320 is, in general, consistent with standard
international practice for safety systems and safety-related systems. The
basic safety concept of defence-in-depth is realized by general design
criteria including the use of redundancy, diversity, independence and
fail-safe design.

However, operational experience has revealed some deficiencies
regarding implementation of engineering design solutions, quality of
manufacture and reliability of equipment used and the consequential
need for safety improvements. Other shortcomings reflect deviations
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from current safety standards which evolved over the last two decades
since the design of WWER-1000 plants.

In February 1992, Bulgaria, the Czech Republic and the Ukraine
separately requested that the IAEA initiate a comprehensive safety
evaluation for WWER-1000 NPPs.

A consultants meeting was held by the IAEA in Vienna in June
1992 to compile information on safety aspects and studies carried out on
the design differences between WWER-1000 plants and similar western
plants as well as safety reviews already performed for this reactor type.
At this meeting, the Member States operating and constructing WWER-
1000 NPPs requested that a compilation be made of all safety concerns
of WWER-1000 NPPs as a reference for plant specific safety
improvements. Therefore, the activities of the IAEA Extrabudgetary
Programme on the Safety of WWER-1000 NPPs were directed at
identifying main safety issues and priority actions, by considering the
major reconstruction programmes for WWER-1000 developed in
Russia, the Ukraine, Bulgaria and Czech Republic, by considering the
results of topical meetings on main generic issues and by considering
safety studies for specific plants such as Stendal and Rovno. These
activities have been complemented by the results of plant specific
reviews carried out within the IAEA Programme. The Safety Review
Mission to Zaporozhe (Ukraine) in 1994 and various ASSET, OSART
and Seismic Safety Missions in all Member States concerned were major
activities in this respect.

This issue list for the WWER-1000/V-320 type of nuclear power
plants was initially drafted by the participants of the consultants meeting
from 3-7 October 1994. It was further reviewed and completed by the
IAEA Secretariat, taking into account the comments from the Steering
Committee, new information made available to the IAEA from the
Rovno Report [13], comments received to date from meeting participants
and harmonization with the issues identified and ranked for the WWER-
440/213 NPPs. A final consultants meeting was convened by the IAEA
from 27 February to 3 March 1995 to harmomze the safety issues and
ranking of both reactor types, WWER-440/213 and WWER-1000/320.
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This finalized list of safety issues is included in a publication of
the Extrabudgetary Programme [14].

The list of the safety issues was taken as a basis for creating a
database on WWER-1000 reactors. The basic primary table, named as
"WWER-1000 Issues" contains the following fields:

ID Identification number (index
field).

Issue number Code number of the issue with the

reference to the topical area.

Issue title Title of the issue.

Clarification Description of the safety concern.

Ranking Category identified on the basis of
degradation of defence-in-depth
(I-IV).

Justification Justification of the category.

The primary tables and the number of records in each table are
included in Table V. Three tables are used only for displaying the data
on the main screen and therefore they are not listed here.

The database includes references to the original publications
where the data were obtained. An interface table with the G-24 Project
Data Bank can be prepared which makes a joint analysis of information
from both databases easier.

To a large extent, the identified safety issues are being addressed
by the relevant Member States within national safety improvement
programmes for WWER-1000 NPPs. Most relevant safety upgrading
measures have been compiled by the "Users Group for Soviet Designed
Reactors - WWER-1000", and are based mainly on the proposals made
by Russian design organizations. The structure of the database (Fig. 7)
allows to reflect both the proposals of national and international
programmes and plant specific status of issues.
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TABLE V. PRIMARY TABLES IN THE WWER-1000
DATABASE

Primary table name

WWER-1000 issues

IAEA recommendations

Measures proposed by Member States

Status

Status plant relation table

Plants

Safety area types

Safety areas relation table

Total:

Number of
records

82

202

103

201

234

12

94

109

1037

These corrective measures proposed by the Member States for
each issue have been reviewed and consolidated in the table "Measures
proposed in Member States". These corrective measures are generic as
are the issues themselves, i.e. in general they are applicable to the units
of the WWER-1000 model 320 NPPs.

The country/plant specific status so far made available to the
IAEA has been included into the database. However, this information is
incomplete, sometimes very general and lacking technical details. It
should be further completed and updated.
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Measures proposed by
Member States

ID
Issue code
Measure

IAEA recommendations
ID
IAEA recommendations
Issue code

WWER-1000 Issues
ID
Issue number
Issue title
Clarification
Ranking
Justification

Status
ID
Issue code
Plant specific status

Safety areas
IAEALINKCODE
saidtcd
pacovpc
pacomtx

Status-plant relation
table

ID
ID Plant

Plants
ID plant
Plant/country name

Safety area types
saidtcd
sadestx

T
G-24 data bank

FIG. 7. Structure of the WWER-1000 database.
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5.2. USER INTERFACE

A dialog screen for easy retrieval of information was developed for
the WWER-1000 database on which all information from the issue list
can be displayed including the plant specific information (Fig. 8). On this
screen the user can select a particular safety issue and display the
information contained in [14].

Start

To open the IAEA WWER-1000 database double-click the
WWER-1000 icon created by the setup programme. Click on the Start
button to display the main dialog screen (Fig. 8) which offers a flexible
way to select information from the database.

Select the issue

An issue may be selected either by its code or by its title in the
upper part of the screen. A new issue may be selected either from the new
issue code or the issue title pop-up lists. (It is sufficient to select either a
new issue code or a new issue title, the other fields change automatically
after a selection is made).

A group of issues may be selected in two ways:

(a) To obtain a subset of issues and recommendations related to a
particular word in the database, type the word in the Find field (at the top
right of the screen) and press enter. The pop-up lists of issue codes and
issue titles will include the results of the search. The lists contain the
issues with the word in any of the text fields.

For example, type ECCS, press enter and the system will display
the selected issues and recommendations with the word ECCS in the text.

(b) To select and display thejull set of issues and recommendations
in the database type an asterisk, (*), in the Find field and press enter.
Accident analysis 1 will be the first issue displayed.
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Issue category, clarification, justification and recommendations

Once the issue code or issue title is selected, the system will
display the category and issue clarification pertaining to the selected
issue in the upper part of the screen.

Click on the Justification button to display the justification of the
category.

Recommendations of the IAEA, measures proposed by the
Member States for the issue and status of the plants were taken from
Ref. [14].

The IAEA recommendations from Ref. [14] are displayed when
the IAEA button at the bottom left of the screen is selected. The system
displays the number of recommendations which the IAEA made for the
selected issue and these can be read in turn when the Next button is
selected (at the bottom right of the screen). This button also scrolls
forward through the entire list of selected issue recommendations. To
scroll backwards click on the Previous button.

Information on the number of measures proposed by Member
States for the current issue are displayed when the Measures button,
bottom left of the screen, is selected.

The Plant status button, bottom left of the screen, is enabled in
boldface letters when plant specific information is available on actions
relating to the selected issue. Click on this button to open the Plant
specific information and national programmes window with different
plant and country names at the bottom. The plant or country names are
enabled in boldface letters when information is available on plant actions
relating to the selected issue. Select a plant or country name and the
system will display the number of items/actions relating to the current
issue. Close the window to continue.
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Menu bar

The database has a customized menu bar with file, references,
print and link menu names. The commands under the menu names are
executed in the following way.

File menu on the menu bar

Copy

To copy text from the clarification, .justification, or
recommendation areas, block and select the text then click on File in the
menu bar and select Copy. (To copy text from the Plant specific
information and national programmes window, block the text and
press Ctrl+C then close the window.) The selected text can be pasted
into a word processing, spread sheet or other application.

Exit

To exit the database, click on Exit in the File menu. All the
Microsoft ACCESS files will be closed and the system will exit the
application.

References menu on the menu bar

Info sources

Click on Info sources from the References menu bar to display a
list of publications used as information sources in the database. Close
the window to exit.

About...

About... displays the names and addresses of the contact
persons, relating to the IAEA Extrabudgetary Programme and the
developer of the database. Click OK to close the window.
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Print menu on the menu bar

Print

To print a selected group of issues (for example, from the Find
operation previously performed), or the issue currently displayed on the
screen, click on Print in the Menu bar and choose Print.... The Report
printing dialogue box will be displayed. Choose Selected items or
Current issue, then select specific related items from the references
which are enabled on the particular issue(s) or AU items (to print all
items related to the issue(s) selected). Click on Print' and the Print
dialogue box will be displayed indicating the default printer name and
the requested print range. To display a preview, before printing, click
on the Print preview button. Click on OK to start printing.

Print setup

The usual Windows Print Setup dialogue box will be displayed.
Choose the printer, orientation, paper size, etc., which are appropriate
for the available hardware. Click on OK to close.

Link with the G-24 Project Data Bank*

Under the Link menu from the customized menu bar two menu
items are available.

Show the link to G-24 Data Bank

Select this item to display the diagram showing the link between
the G-24 Project Data Bank and the IAEA databases. Click on OK to
close.

Export link table

If the G-24 Project Data Bank is installed on your computer you
can create a table which provides a link between the IAEA technical

* For the G-24 Project Data Bank contact the G-24 NUSAC Secretariat in Brussels.
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databases and the G-24 Project Data Bank. Click on Export link table
to display the Generate table linking to G-24 Project Data Bank
dialogue box. The Generate button creates a link table for the selected
issues or the currently displayed issue. After generation, the Export
button is activated in bold face letters. Type in the correct path to the
G-24 data bank on your PC, then click on Export. An error message
will be displayed if the indicated path is incorrect. Click on OK and
make the necessary change to the path, then click on Export again. The
table will be exported to your G-24 data bank file which can then be
used for further analysis.

Note, if the export operation is cancelled after generation of the
table, generation must be made again before the export function can be
performed.

6. LINK TO THE G-24 PROJECT DATA BANK

In 1992 the G-24 NUSAC was requested to develop a data bank
containing assistance projects in the field of nuclear safety of Eastern
and Central European nuclear power plants.The objective of the
database was to support the G-24 co-ordination mechanism.

From the very beginning, the IAEA was asked to assist in the
elaboration of the structure, provision of data on the IAEA's activities
and suggestions for the further improvement of the data bank.

The IAEA entries in the G-24 Project Data Bank are updated
three times a year in order to maintain up-to-date information on IAEA
activities.

As a result of the early involvement of the IAEA in the
development of the G-24 Project Data Bank, it was possible to develop
both the IAEA technical databases and the G-24 Project Data Bank in
such a way that they can be linked and jointly analysed. This link is
implemented through the common tables in all databases contaimng the
safety areas which are addressed by the issues or projects. The structure
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V-230
Safety issues
Recommendations
Plant status
Related area

V-213
Safety issues
Recommendations
Plant status
Related area

Main safety aspect
Safety function or

area

WWER-1000
Safety issues
Recommendations
Plant status
Related area

RBMK
Safety issues
Recommendations
Plant status
Related area

FIG. 9. Link between the G-24 Project Data Bank and the IAEA
databases.

of this link is shown in Fig. 9. In the IAEA databases the user can create
a table which links the selected issue or the group of issues to the G-24
Project Data Bank by selecting this action from the menu.

A joint analysis can be run to produce some indicators of the
assistance activity, for example, the number of projects addressing a
particular safety issue or group of issues. In preparing these types of
queries several attributes of the projects (donor and/or recipient
countries, status, aid-type, final product etc.) and issues (category, status
of implementation etc.) can be specified. This type of analysis can
support overall or topical reviews but should not be used an absolute
measure of the assistance efficiency.
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ABBREVIATIONS

ASSET Assessment of Safety Significant Events Team (IAEA)

ECCS emergency core cooling system

G-24 Group of 24 OECD countries

NPP nuclear power plant

NUSAC Nuclear Safety Assistance Co-ordinatioa

OECD Organisation for Economic Co-operation and
Development

OSART Operational Safety Review Teams (IAEA)

PC personal computer

RBMK light boiling water cooled graphite moderated pressure
tube type reactor (Soviet design)

RDIPE Research and Development Institute of Power
Engineering (Moscow, Russia)

VGA PC graphic adapter and display standard

WANO World Association of Nuclear Operators

WWER water cooled water moderated energy reactor (Soviet
design)
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